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1
This chapter provides

m a brief introduction to the Internet

m an overview of Cyberdog

m an overview of this manual

m instructions on using online help

m what you need to know information

Introduction to Cyberdog



About the Internet

You’re about to use Cyberdog to access the Internet. But before you get
started, you might be wondering what the Internet is.

Simply put, the Internet is a loosely knit federation of computer
networks that “speak” the same language. The language in this case is a
communications standard known as the Internet Protocol, or IP for
short.

You need the right equipment to connect to the Internet—a computer, a
modem, and communications software. If you don’t have a modem, you
may be able to connect through a local area network (commonly called
a LAN) that has been set up in your company or your school. Then,
using Cyberdog, you can gain access to the Internet services and public
areas described in the following sections.
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World Wide Web

The World Wide Web (also referred to as the Web) is the Internet’s
newest and easiest service for accessing information. You view
information on the Web by using software called a Web browser. You can
view text, color images, animation, and video on the Web. The
“documents” that you view on the Web are known as Web pages, which
can contain links to other pages so that when you click a word or image
that has been designated as a link, your browser will automatically
display the contents of the linked page.

You are transported from one page to another by a hypertext link—an
electronic connection to the new information activated by your clicking.
The new information may reside in the same computer or in one on the
other side of the world. Gaining access to distributed information
through hypertext links is at the heart of the World Wide Web.

E-mail

You use electronic mail, or e-mail, to exchange information in much
the same way that you use paper mail, except that e-mail is faster and
more convenient. You can also attach entire files to e-mail.

Newsgroups

You can participate in newsgroups—worldwide public discussion
groups for debating issues and for exchanging information. You can
subscribe to a newsgroup for almost any topic imaginable (there are
over ten thousand distinct newsgroups), and you can read, respond to,
and create your own messages, usually referred to as articles. Most
newsgroups are unmoderated, which means you can post your articles
directly to the newsgroup. Other newsgroups are moderated, which
means someone screens the articles and posts only those deemed
appropriate for the newsgroup.
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FTP

You use File Transfer Protocol (FTP) to transfer files to or from other
computers on the Internet. Many specialized computers known as
servers provide Internet users with files through FTP. FTP software
comes in handy when you want to download (copy to your computer)
software or software updates over the Internet.

Telnet

You use Telnet to log onto other computers so that you can use their
programs and data as if those items were on your own hard disk. Many
libraries, for instance, have electronic (online) card catalogs that you
can access by using Telnet software. There are a variety of other
specialized databases that you can access through Telnet.

With all the services and capabilities that the Internet provides, the
Internet or “Net” as it’s called, is a truly global resource, with an
amazing amount of information on art, anthropology, engineering,
finance, literature, marketing, music, and virtually every other area of
interest imaginable. Through the Internet, you can reach information
located across the planet and contact millions of other users around the
world.

About Cyberdog

Cyberdog is an integrated suite of software that gives you full access to
the Internet. Cyberdog allows you to:

m browse and search the World Wide Web

m receive, send, sort, and process e-mail

m read and retrieve articles from newsgroups

m browse AppleTalk zones and servers

m exchange files with file transfer protocol (FTP)

m log on to other computers with Telnet software

m create interactive Internet documents called cyberdocuments
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Cyberdog also includes a Notebook and Log to store the Web sites you
visit the most. The Notebook is a bookmark file of Web addresses as
well as a place to store e-mail addresses, newsgroups, references to FTP
and Gopher sites, Telnet sessions, and references to pictures, movies,
text documents, and sound files on the Internet. The Log provides three
powerful ways to view a history of your Internet activities.

Additional Cyberdog product information is available on the Internet at
http://cyberdog.apple.com/geninfo.html#.

New features of Cyberdog 2.0

Cyberdog 2.0 feature information is available on the Internet at
http://cyberdog.apple.com/documentation.html.

Using this manual

Cyberdog provides you with full access to the World Wide Web, as
detailed in Chapter 3, “Exploring the World Wide Web.” Cyberdog is
also a versatile and powerful tool for electronic mail (e-mail).
Cyberdog e-mail capabilities are covered in Chapter 4, “Sending and
Receiving Mail.” Cyberdog also provides access to other popular and
useful Internet services, including newsgroups, Telnet, and file transfer
protocol (FTP), which are covered in Chapter 5, “Using Other Internet
Services.” A unique Cyberdog feature is the ability to access
AppleShare volumes directly from the browser. This is covered in
Chapter 6, “Accessing AppleTalk Networks.” With Cyberdog, you can
both access information and make information available. You do the
latter by creating cyberdocuments that can be accessed by other
Cyberdog users. For information on building cyberdocuments, see
Chapter 7, “Creating Cyberdocuments.” 

Depending on your interests and experience, you can cover each topic
in order or skip directly to those topics you need to know more about. 
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Using online help

Cyberdog includes full online help in the form of Apple Guide. If you
need help or more information on any topic in this manual or on any
problem you encounter while using the software, open the Guide (h)
menu and choose Cyberdog Guide. Then click the topic you need 
help with.

Before you get started

Before you can use your Cyberdog software, you must possess basic
Macintosh skills, including the ability to

m use icons

m use the mouse and keyboard

m open and close files, windows, and folders

m use dialog boxes

See the instructional materials that came with your computer for
information on these and other important topics.

12 Chapter  1  In t roduct ion to  Cyberdog



13

2
This chapter provides

m a summary of requirements for using the software

m instructions on installing and starting the software

m steps to begin using the software

Getting Started With Cyberdog



System requirements

In order to use Cyberdog, you’ll need these items:

m a PowerPC-, 68030-, or 68040-based computer using the Mac OS

m Macintosh system software version 7.5 or later. Version 7.5.5 is
recommended.

If you have an earlier version of the system software, you can obtain
an upgrade from your Apple-authorized reseller. You can also obtain
the software from the Internet at http://support.info.apple.com. 

m OpenDoc version 1.1 or later (version 1.2 is recommended), which
you can download from the Internet. A pointer to the OpenDoc Web
page is included on the Cyberdog Web page at
http://cyberdog.apple.com.

m QuickTime software version 2.1 or later, which may be included with
your system software and can also be downloaded from the Internet
at http://support.info.apple.com

m MacTCP 2.0.4 or later, which is included with some versions of
system software, or Open Transport 1.1 or later, which is included
with Macintosh system software version 7.6 or can be downloaded
from the Internet at http://support.info.apple.com

m MacPPP version 2.5 or later or other SLIP/PPP software for dial-up
connection, included with Macintosh system software version 7.6

m an SMTP/POP3 mail account
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m 16 megabytes (MB) of random-access memory (RAM) are
recommended. If virtual memory is turned on, Cyberdog will run
with 8 MB of RAM.

m a Mac OS–compatible modem capable of transmitting data at 14.4
Kbits per second (Kbps) or faster connected to a telephone line, or
direct Internet access through a local area network (LAN)

Also recommended are

m Internet Config 1.2 or later for more efficient handling of preferences

m Stuffit Expander for expanding compressed downloaded files

Installing the software from the Internet

Follow these instructions to install the Cyberdog software from the
Internet:

1 Using your current browser (Cyberdog or another browser), connect to the Cyberdog
Home Page.

The Uniform Reference Locator (URL), or address, of this page is
http://cyberdog.apple.com.

2 Click the “Download” link.

The URL of this page is http://cyberdog.apple.com/download.html.

3 Follow the instructions on the screen to download Cyberdog 2.0 and Cyberdog Guide.

4 Return to the Cyberdog Home Page and click the link to the OpenDoc Home Page.

5 Download OpenDoc version 1.1 or later.
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6 Install OpenDoc and Cyberdog following the instructions on the screen.

IMPORTANT  You must install the OpenDoc software first.

The Cyberdog installation creates a folder called Cyberdog 2.0.
OpenDoc is installed within the System Folder.

7 Drag the Cyberdog Guide file to the Cyberdog 2.0 folder.

Setting up an account with a service provider

To connect to the Internet, you need an account with a company, called
an Internet Service Provider or ISP, that can provide you with Internet
access. Your computer may include the Internet Setup Assistant, which
is a program that will assist you in setting up an account and
configuring your computer for the Internet.

Starting up with Cyberdog

Follow these instructions to start Cyberdog:

1 Double-click the Cyberdog 2.0 folder to open it.

2 Double-click the Cyberdog Tour icon.

The Cyberdog Tour window appears.
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Each of the Cyberdog Tour buttons either allows you to make use of an
Internet service (such as the World Wide Web, e-mail, or newsgroups)
or connects you to important elements of Cyberdog, such as the
Notebook or the Log.

m Explore connects you to a Cyberdog page on the World Wide Web.

m Mail displays e-mail that you have sent or received.

m Notebook keeps your most frequently used e-mail addresses and
your favorite Internet locations.

m Log records the Internet locations you’ve visited.

m AppleTalk opens a window that allows you to browse and connect to
AppleShare servers (if you are connected to an AppleTalk network).

m News brings up a list of the newsgroups to which you have access.

m Search enables you to scan the Internet using a variety of popular 
search engines.

Learning to use the software

This manual provides basic information on all the features available
through the Cyberdog Tour window. As noted earlier, detailed online
help is also available. To learn how to use Cyberdog, follow these
instructions:

1 Read the section of this manual that covers the feature you want to use.

2 Click the Cyberdog Tour button that starts that feature.

For example, click Mail (for electronic mail) or Explore (to browse or
“surf” the Web).

3 Choose Cyberdog Guide from the Guide (h) menu.

4 Click Topics.

5 In the list that appears, click a topic area that deals with the Cyberdog part you’re using
(for example, mail).

6 Locate the task you want to accomplish and double-click it.

7 Read the information and follow the instructions in the Guide panels.
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For more information on using onscreen guides, see the “Learning the
Basics” topic of Macintosh Guide, available in the Guide (h) menu
when the Finder is the active program.

There may also be additional help for specific features. Check the
Guide (h) menu and other menus to see what’s available.
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The World Wide Web refers to the portion of the Internet that provides
information according to the Hypertext Transfer Protocol (http), a
standard that enables the exchange of both graphics and text. The Web
is the section of the Internet that has grown most explosively over the
past few years, with companies, organizations, and individuals setting
up Web pages by the thousands. 

This chapter provides information about

m using Cyberdog to connect to a Web page

m using Cyberdog to browse through information on the Web

m using Cyberdog to search for specific information on the Web

m using the Log

m adding Web sites to your notebook

m importing Netscape bookmarks

For additional information about the Web, see the “Browsing the Web”
topic area of Cyberdog Guide, available in the Guide (h) menu when
Cyberdog is active.
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Connecting to a Web page

Every Web page has its own unique address, called a Uniform Resource
Locator (URL). If you already know the URL of the Web page you
want to connect to:

1 Choose Connect To from the Cyberdog menu.

The Connect dialog box appears.

2 Type the URL of the page you want to connect to in the “Connect to URL” box, then click
OK.

Note: You can switch to a different location from any Web page by
typing a URL into the Location box at the top of the current Web page
window. You don’t have to type in the Web URL prefix http://. If you
don’t specify a URL prefix, Cyberdog automatically assumes you want
to connect to a World Wide Web page.
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Browsing the Web

This section tells you how to use Cyberdog to “surf” (browse) the Web.

1 Open the Cyberdog Tour window.  

Double-click the Cyberdog Tour icon in the Cyberdog 2.0 folder. The
screen shown below appears:

2 Click the Explore button.

A small opening window and a moving dog icon appear, indicating that
your computer is in the process of connecting. The message next to the
icon indicates which phase of the connection is in progress.

To cancel the connection, click the dog icon.
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When enough information has arrived, the window expands to full size
and displays the Cyberdog Net Station page. From the Net Station, you
can access the entire Internet. 

Chapter  3   Explor ing the Wor ld  Wide Web22



Clicking any of the underlined items takes you to that site or service. 
If, for example, you click “Apple Computer Home Page,” a page similar
to the following appears:
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Depending on how the Web page author designed the page, links can
appear as buttons, or they can appear as “hot text,” text that is
underlined and in a contrasting color (if your display supports color).
By clicking from one link to the next you can search a series of Web
pages in pursuit of the information you’re seeking. 

Note: When you move the pointer over a link, the URL for that link
appears at the bottom of the current page’s window.

3 Click an underlined item or a button.

When you click, a hypertext link takes you from one page to another.
For example, clicking “Van Gogh” on a page about artists may lead you
to a page about Van Gogh’s homeland, the Netherlands. That page is
likely to include links to articles about windmills, tulips, and religious
tolerance. Before long, you can be far afield from your starting point.
(You can see why the software you use to navigate the Web is called a
browser.) There are a variety of means to retrace your path or return to
the page where you started. 

4 Return to the previous page by clicking the left-pointing arrow in the upper-right corner
of the page.

Searching for specific information

You can search for specific information on the Web by using a search
engine to isolate lists of links that are likely to bring you to the
information you need.

1 Open the Cyberdog Tour window.

Double-click the Cyberdog Tour icon in the Cyberdog 2.0 folder or, 
if Cyberdog is running, choose Open from the File menu and open
Cyberdog Tour.
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2 Click the Search button.

When the connection has been made, a page similar to the following
appears:
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3 Enter your query in the box.

This box allows you to enter a simple query. If you want to 
enter a more complex query, which permits you to focus your 
search more closely, click the Alta Vista link and go directly to the 
Alta Vista Web page.

4 Click Search.

An alert box appears warning you that the document is not secure:
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5 Click OK.

The search begins, with results similar to those shown below.

There are numerous search engines available. Many of these can be
accessed from the Cyberdog Net Station, discussed earlier in this
chapter. They all work the same way. Trial and error will show you
which engines give the best results to your queries.
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Using the Log

The Log holds the address of Web site locations you’ve visited in recent
sessions. To connect to a location from the Log:

1 Choose Windows from the Cyberdog menu, then choose Show Log from the submenu.

2 Find and double-click the address icon you want.

For additional information about the Log, see the “Using the Log” topic
area of Cyberdog Guide, available in the Guide (h) menu when
Cyberdog is active.

Saving Web site addresses

As you find Web sites you think you’ll want to revisit, you can save them
in a Cyberdog notebook. That way, you can connect simply by double-
clicking the URL in the notebook, with no need to remember or type the
URL itself.

1 With the Web page you want to add open on the screen, open a Cyberdog notebook.

You can open a notebook in any of these ways:

m Click the Notebook button in the Cyberdog Tour window.

m Choose Open Document from the File menu and select a notebook
to open.

m Choose Windows from the Cyberdog menu, then choose Show
Default Notebook from the submenu.

m Double-click the Notebook icon in your Cyberdog 2.0 folder.

After you have been using Cyberdog for a while, you may have several
notebooks. If you are new to Cyberdog, you have a sample notebook,
called Cyberdog 2.0 Notebook, which already contains a selection of
Web sites and e-mail addresses.
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2 Click the icon in the top-left corner of the browser, next to the title of the page you’re
using, and drag the icon to the appropriate section of the notebook.

You can also choose “Add Window to Notebook” from the Cyberdog
menu.

An abbreviation of the URL is added to the list. The next time you
want to access this page, simply double-click the notebook entry. 

For additional information about notebooks, see the “Saving and
Organizing Addresses” topic area of Cyberdog Guide, available in the
Guide (h) menu when Cyberdog is active.
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Importing Netscape bookmarks

If you have been using Netscape Navigator and have created bookmarks
to access Web pages, you can import those bookmarks into a Cyberdog
notebook.

1 Open the notebook you want to store the bookmarks in.

2 Choose Import Items from the Notebook menu.

3 Choose Netscape Notebooks from the Import Items submenu.

A dialog box appears with Bookmarks.html already selected.

4 Click Open.

A new category, Bookmarks.html, is added to your notebook. If you
click the triangle next to the category heading, all the bookmarks
appear. Double-clicking any one of them takes you directly to that 
Web page.

Note: You can also import Eudora and Claris Emailer addresses; these
options are available in the Import Items submenu.
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A note about performance

Sometimes connecting to a Web site may take longer than you expect.
Several factors can affect connection time, including your modem’s
speed and the distance to the site. 

One of the most important factors, however, is the server that you’re
contacting. Some extremely popular servers may be processing many
requests for use at the same time, and some servers are just slower than
others. After a while, you’ll learn which servers provide you with the
best performance.

Chapter  3   Explor ing the Wor ld  Wide Web31



Chapter  3   Explor ing the Wor ld  Wide Web32



You use electronic mail (e-mail) to exchange messages much as you use
paper mail or a fax machine. 

This chapter describes how to

m determine if e-mail is set up

m set up Cyberdog for e-mail

m read e-mail

m send e-mail

m attach a file to your e-mail message

m use mail handlers

m create a new letterhead

m create an address book

m import addresses from mail programs
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Checking whether e-mail is set up

Follow these steps to check whether you have e-mail already set up:

1 Open the Cyberdog Tour window.  

Double-click the Cyberdog Tour document in the Cyberdog 2.0 folder,
or, if Cyberdog is already running, choose Open from the File menu
and open the Cyberdog Tour window.

2 Click the Mail button.

If you have been using a mail application with mail preferences already
set up in Internet Config, such as Eudora, Cyberdog opens the Mail
Trays window and displays an In Tray corresponding to that Internet
mail account. This means that your Cyberdog mail account is set up
and functioning.

If the In Tray shows that mail has been received, go to the section
“Reading a Message” for information on receiving and replying to mail
messages.

If Cyberdog prompts you to use Mail and News Setup from the
Mail/News menu, or if you want to change your mail settings, you need
to set up mail. Follow the directions in the next section. For additional
information, see the topic area “Getting Started” in Cyberdog Guide,
available in the Guide (h) menu.

Setting up Cyberdog for e-mail

The following section provides a basic setup scheme. For detailed
information, see Cyberdog Guide as you perform these steps.

IMPORTANT  In order to use Cyberdog mail, you need an Internet mail
account that uses the POP protocol to receive mail and the SMTP
protocol to send mail. Your Internet service provider can give you the
information you need to set this up.



1 Choose Mail & News Setup from the Mail/News menu.

The following dialog box appears.

2 Enter a default mail address.

This is your standard e-mail address, such as Lsmith@bigcom.com. It
appears in the From field on your messages and is the address people
use to send you mail.

3 Enter the name of your SMTP host.

Your network administrator can tell if you need to enter the SMTP host
name, and, if so, what name to enter.

4 Choose the mail notification features you want: a dialog box, a flashing icon, a sound, or
all three. 

If you don’t check any notification type, you won’t be notified, but you
can still check mail at any time.

5 To set the default folder for mail trays that you create, click Set Folder. Then select a
folder from the scrolling list and click the “Save in” button.

If you don’t set a default folder, the CyberMail folder in the Cyberdog
Preferences folder is used as a default folder.
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6 Click the Mail Trays icon.

7 Click Add under Mail Accounts. 

The following dialog box appears. You use this dialog box to set up
your POP account to download mail from the Internet mail server. 

8 Enter your account name.

This is your user name, not your e-mail address; for example, if your
e-mail address was bonzini@internet.com, you would enter bonzini.

9 Enter the host.

This is the mail server, such as mail.bigcom.com, as supplied by your
Internet service provider.

10 Enter your password.

Your network administrator will usually provide you with the password
to use. 

11 If you want to save your password, click Save Password.

If you click Save Password, you won’t have to enter your password each
time you download mail.
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12 If your e-mail server supports Authenticated Post Office Protocol (APOP), click the Use
APOP” checkbox to put an X in it.

APOP is a method of sending e-mail server passwords in encrypted
format so the password remains private during transmission.

If you’re not sure that your e-mail server supports APOP, leave the box
unchecked.

13 If you want Cyberdog to automatically check for mail as soon as the connection is made,
click the “When mailbox is opened”checkbox to put an X in it.

14 To check for mail at regular intervals, click the Every checkbox to put an X in it. Then
type a number into the checkbox and choose a unit of time (minutes, hours, days) from
the pop-up menu.

15 If you want to leave copies of mail you have read on the server, click the “Leave a copy”
checkbox.

You probably only want to leave copies of the mail on the server if you
are reading your mail from several different computers rather than one
computer.

16 Click OK.

17 Click the Messages icon.

The Messages screen appears.

18 Select the “Show buttons in envelope” option to show the buttons at the top of the
message window.

19 Select “Expand envelope when creating a letter,” “Expand envelope when opening a
letter,” or both to adjust the default setting for envelope behavior.

This is the part of the message window that contains the To, CC, BCC,
Return Receipt, and Rich Text options.
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20 Select the “Close letter window after sending” option to have Cyberdog automatically
close the message window when you send it.

21 Select who your e-mail replies will be addressed to in the “Reply to mail” section.

Click “Author” to reply only to the person who sent the message. Click
“All recipients” to reply to the author and the addresses in the CC
boxes.

22 Select who your news replies will be addressed to in the “Reply to news” section.

Click “Author” to reply via e-mail only to the person who wrote the
article. Click “Newsgroup” to reply to the newsgroup. “Both” sends your
reply to the author and posts a copy to the newsgroup.

23 Select the text in the original message to be included in your replies in the “Text to
include” section.

Including the original message in your reply provides a context for your
response.

Click “Selected” to include a portion of the original message that you
select. Click “All” to include the complete original message when you
reply.

24 If you want to insert a line in your reply that identifies the author of the text you’re
quoting, click the “Attribute text to author” checkbox to place an X in it.

25 Select “permanently” to save all of the messages that you send or “for x days” to have
Cyberdog delete your sent messages after a specified period.

26 Click the Letterhead icon.

27 To select the letterhead you want to use for your messages, click to the left of the
letterhead in the list.

The dot will appear next to the letterhead you select.

28 Enter the name you want to appear in the From field in the My Name text box.

The name will appear along with your e-mail address; for example,
Fred Bonzini <bonzini@apple.com>

29 Click OK.
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Reading a message

Once you find mail in your In Tray, follow these steps to read your
messages:

1 Open the Cyberdog Tour window and click the Mail button.

You can also choose Show Mail Trays from the Mail/News menu. The
Mail Trays window appears.

Note: You can designate the style of buttons that appear in the Mail
Trays window (no buttons, icons and text, or text only) by choosing
Mail & News Setup from the Mail/News menu, clicking the Mail Trays
icon, and selecting the style you want from the “Mail Tray buttons”
pop-up menu.

2 Double-click the In Tray icon.  

A list of the messages that you’ve received appears. Checkmarks appear
beside messages that you’ve already read. 

Note: If you want to mark the message as unread, click the checkmark
to remove it.

3 Double-click the message you want to read.

A message window appears. 

4 Use the onscreen buttons to forward, reply to, file, or delete the message.

You can also use the left and right arrows at the top of the window to
move through the unread messages in your mail tray.

For additional information about reading messages, see the “Reading
Mail” topic area of Cyberdog Guide, available in the Guide (h) menu
when Cyberdog is active.
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Composing and sending a message

This section takes you through the steps of composing and sending an
e-mail message with Cyberdog. 

1 Choose New Message from the Mail/News menu.

2 Enter the subject of the message in the Subject box.

IMPORTANT  You must include a subject or the message cannot be sent.

Many people who receive a lot of electronic mail determine whether
they’ll read a message based on this field. This is especially true if they
don’t know the sender. Give your message a subject that is as
descriptive as possible.

3 Enter the e-mail addresses of recipients in the To box.

You can enter an address by

m typing the address into the To box.

m copying the address and pasting it into the To box.

m dragging an address icon from a notebook, the log, a newsgroup’s
window, a folder, or the desktop.

m using an address in the default notebook by clicking the Addresses
button in the Message window.

E-mail addresses usually take this form:

recipientName@recipientMailServer

where recipientName is the name that the recipient goes by when he or
she connects to that mail server and recipientMailServer is the
recipient’s mail server name.

You can also address an e-mail message by double-clicking an e-mail
address icon or clicking an e-mail link on a Web page. Doing so opens
a new e-mail message form with the e-mail address already in place.

You can send the same electronic message to multiple recipients by
adding additional addresses.
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About suffixes:  An e-mail address usually ends in a two- or three-letter
code. This code identifies the country in which the server is located
(two letters) or the kind of organization with which the mail server is
associated (three letters). Some common national codes are “us”
(United States), “jp” (Japan), “uk” (United Kingdom), and “fr”
(France). Common organizational codes include “com” (commercial),
“edu” (educational), and “gov” (government).

Some recipient names consist of numbers instead of letters. The
CompuServe online service, for example, uses the recipient’s member
number with the comma replaced by a period (for example,
12345.678@compuserve.com).

Here is a list showing how to address mail to members of other popular 
online services:

Service Addressing method

America Online recipientName@aol.com

Prodigy recipientName@prodigy.com

MCI Mail recipientName@mcimail.com

Because e-mail addressing specifics can vary, and because there is as
yet no reliable or even remotely complete address database, the only
way to know what e-mail address to use is to get it directly from a
recipient, a recipient’s correspondence or newsgroup posting, or a
recipient’s associate.

Copies and blind copies:  Just as you can send copies (cc) of paper
mail, you can send copies of e-mail. People receiving copies of your
message also receive copies of any attached files (described later in 
this chapter).

Recipients who receive “blind copies” (bcc) also receive copies of
everything sent to the main recipient. None of the recipients, however,
knows who the bcc recipients are, because names and addresses of
blind recipients are removed from the message when it’s sent.
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4 If you want to be notified that your message was received, click the “Return receipt
requested” checkbox to put an X in it.

A receipt means that the address is correct and that the mail server
received the message, but not necessarily that the mail server delivered
the message to the intended recipient or that the recipient read it.

Not all mail servers offer this service. If the request goes to a server
that doesn’t offer the service, you won’t get a receipt, whether the
message was received or not.

5 Select Rich Text (MIME) or Plain Text.

Rich Text should be used when you want to include formats, styles, and
pictures in your message. Note that in order to view the formats and
styles in a Rich Text message, the recipient must have a MIME-capable
viewer such as Cyberdog.

6 Type your message in the Content section.

If you know how to use any plain text editor or word processor, you can
compose an electronic message in Cyberdog. You type your electronic
message using all of the standard Macintosh editing features, just as
you would type a fax or a letter to be printed and mailed. You can use
any available font, size, style, and color, but keep in mind that the
recipient’s mail application might affect the look of your message. If the
e-mail recipient’s system can’t take advantage of the styled text and
graphics, it is probably best to stick to plain text. To specify a plain text
message, choose Plain Text from the pop-up menu at the bottom right
of the message header. 

7 Add any graphics that you want to include in the body of your message. 

8 Add any files that you want to include with your message. 

To add a file, drag it to the text area of the message, or click the Enclose
button in the message window.

You can attach files in any format you want. However, the recipient’s
computer must be able to understand the attachment’s format. For
example, if your recipient’s computer is an IBM mainframe, it won’t be
able to read a HyperCard stack. 



Additionally, not all mail server systems are set up to receive
attachments. An attachment sent to such a system can get removed in
transit, show up as garbled mail, or cause the whole e-mail message to
be rejected. 

To make sure that a mail server can receive and understand an
attachment, contact your intended recipient and ask. If your recipient
doesn’t know, try sending a test attachment first.

9 If you want to include links to AppleShare servers or Internet locations, drag those items
from the Notebook to the message window.

10 Send your message.

To send your message immediately, click the Send Now button at the
top of the Message window.

To send the message later, click Send Later. When you are ready to
send the message, select the message in the Out Tray then open the
Message menu and choose Send Now.

For additional information about sending messages, see the “Sending
Mail” topic area of Cyberdog Guide, available in the Guide (h) menu
when Cyberdog is active.

Using mail handlers

You use mail handlers to sort your e-mail automatically. Mail handlers
can control the way messages appear in a mail tray and in what mail
tray the the messages appear. For example, you can make messages sent
by a particular person stand out by choosing a color for their titles, or
you can throw away messages about a given subject without reading
them.

To create a mail handler:

1 Choose Mail & News Setup from the Mail/News menu.

2 Click the Handlers icon.
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3 Click Add under Mail Handlers.

The following dialog box appears:

4 Type a name for the handler in the Name box.

5 Click a checkbox in the When section to put an X in it.

At least one When specification must be complete for a handler to
work.

6 Open the pop-up menu and choose a field.

Cyberdog looks in this field for the word or phrase you enter in the
adjoining “contains” text box.

7 Type the word or phrase you want Cyberdog to look for in the “contains” text box.

The more specific you are, the fewer situations the handler applies to.

If you want, repeat this step for one or two more When specifications.
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8 Click the checkbox labeled “Put letter in mail tray” to put an X in it.

9 Choose the mail tray where you want this handler to put messages from the pop-up
menu.

10 Click the checkbox labeled “Set display color to” to put an X in it.

11 Click the color box to choose a color for the messages you have specified in this new
mail handler.

12 To make this handler apply to outgoing mail, click the “Outgoing letters” checkbox to
put an X in it.

13 Click the checkbox labeled “Mail tray” to put an X in it.

14 Choose the In Tray whose messages you want this handler to apply to from the pop-up
menu.

15 Click OK.

You can make the handler take effect immediately on any messages in a
mail tray that meet the handler’s specification. With the mail tray open,
choose Select All from the Edit menu. Then choose Apply Handlers To
Selection from the Mail/News menu.

For additional information about mail handlers, see the “Organizing
Mail” topic area of Cyberdog Guide, available in the Guide (h) menu
when Cyberdog is active.
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Creating a new letterhead

A letterhead is a reusable message template. A letterhead can have all
its addressing boxes filled in, message text already written for form
letters, and signature text at the bottom containing special information,
such as your postal mailing address or telephone numbers.

To create a new letterhead:

1 Choose New Message from the Mail/News menu.

2 Enter the information you want to appear in your Letterhead.

For instance, enter a subject and the text you want to appear in the
content section.

3 Choose “Save as Letterhead” from the Message menu.

The following dialog box appears:

4 Enter the name of the new letterhead.

5 If you want the letterhead you are creating to be the default letterhead, click the
checkbox.

6 Click OK.
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Adding, deleting, and renaming addresses

A Cyberdog notebook can hold e-mail addresses as well as URLs. 

Follow these steps to add an address to a notebook:

1 Open the notebook you want to use.

You can open a notebook in any of these ways:

m Click the Notebook button in the Cyberdog Tour window.

m Choose Open Document from the File menu and select a notebook
to open.

m Choose Windows from the Cyberdog menu, then choose Show
Default Notebook from the submenu.

m Double-click the Notebook icon in your Cyberdog 2.0 folder.

2 Drag an address from an open e-mail message to the appropriate category of the
notebook.

Alternatively, you can choose “Add E-mail Address to Notebook” from
the Mail/News menu and then type the address.

To delete an e-mail address or other entry from the notebook, use any
of these methods:

m Drag the notebook item to the Trash.  

m Select a notebook item and press the Delete key.  

m Select a notebook item and choose Delete Item from the Edit menu.

To rename an e-mail address or other notebook item:

1 Select the name of the item you want to rename.

2 Choose Rename Item from the Edit menu.

You cannot rename a notebook item by selecting it and typing over it. 

3 Type the item’s new name.

For additional information about notebooks, see the “Saving &
Organizing Addresses” topic area of Cyberdog Guide, available in the
Guide (h) menu when Cyberdog is active.
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Importing addresses from mail programs

You can import Eudora or Claris Emailer e-mail addresses directly into
Cyberdog.

IMPORTANT  To import Claris Emailer addresses, you must open Claris
Emailer and export the addresses before you begin.

1 Open a Cyberdog notebook.

2 Choose Import Items from the Notebook menu.

3 Choose Eudora Nicknames or Emailer Addresses from the Import Items submenu.

4 Locate and select the e-mail address file you want to import, then click Open.

The addresses are automatically added to the notebook.
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In addition to the Web and e-mail, Cyberdog offers access to these 
Internet services:

m newsgroups, worldwide public discussion groups for debating issues
and for exchanging information

m FTP (File Transfer Protocol), which enables you to exchange files
with computers on the Internet and sometimes to retrieve programs
that more general Internet software cannot

m Gopher, which allows you to find and access files anywhere on 
the Internet

m Telnet, which enables you to connect to a remote computer

5 Using Other Internet Services



Participating in newsgroups

You can subscribe to a newsgroup for almost any topic imaginable
(there are over twenty thousand distinct newsgroups), and you can read,
respond to, and create your own messages.

Each newsgroup is composed of a series of electronic messages (called
articles) on a given topic. The article themes (which Cyberdog and
many other news readers call threads) can be anything related to those
topics.

With Cyberdog, you can read the articles in any newsgroup and
respond to them by sending e-mail to the entire newsgroup or to the
article’s author (known as the poster). In most newsgroups, you can also
respond by “posting a follow-up”—that is, publishing your own article.
Additionally, you can start your own discussion, or “initiate a thread.”
And you can even propose a topic for an entirely new newsgroup. 

For additional information about news, see the “Reading News” and
“Posting News” topic area of Cyberdog Guide, available in the Guide
(h) menu when Cyberdog is active.
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IMPORTANT  The group news.announce.newusers is the first newsgroup to
which you should subscribe. Read the articles in this newsgroup before
you post an article of any type, or even respond to an article by e-mail.
These articles are written and updated by extremely experienced
newsgroup users and present excellent suggestions for participating in
newsgroups. Articles in this newsgroup are updated and reappear often,
most on a monthly basis. 

Most Internet access providers don’t carry all the newsgroups available
because there are so many of them. Currently there are well over
10,000 newsgroups worldwide (not counting newsgroups restricted to
smaller communities, colleges and universities, and corporations), and
newsgroups are constantly being created and abandoned. A new one is
created when enough people feel the need for it; an old one goes out of
existence when people stop posting articles to it.

Understanding newsgroup names

You can tell what a newsgroup is about by examining its name. When a
name has more than one part to it, the parts are separated by periods,
and go from most general to most specific, left to right. For example,
the newsgroup soc.culture.ecuador covers social topics (“soc”) having to
do with the customs, habits, arts, and day-to-day life (“culture”) of the
people of Ecuador.

The first word in a newsgroup’s name is considered the top-level
hierarchy name, which indicates the newsgroup’s main subject matter.
Cyberdog displays this hierarchy the same way files are displayed in the
Mac OS file system. Each category has a triangle next to its name, as
does a Mac OS folder. Clicking that triangle shows its contents.
Clicking the triangle again closes the category.
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The following is a list of some of the most widely read or important
hierarchies. Some of these newsgroups may not be available to you.

Hierarchy Subject matter

alt Unrestricted, often controversial subjects such as sexuality, drugs, and politics 
(not all groups carried by all sites)

biz Business topics, product reviews, demonstration software

comp Topics in the world of computers

hiv Information about HIV and AIDS 

k12 Kindergarten through grade 12 educational curriculum, classroom projects,
language exchanges with native speakers, general “kid-to-kid” chatting

misc Themes not easily categorized under other hierarchies

news Groups concerned with newsgroups

rec Recreational pursuits, arts, and hobbies

sci Research findings in, discussions about, and applications of recent discoveries 
in the established sciences

soc Social issues and socializing (not all groups carried by all sites)

talk General discussions of a freewheeling nature on every topic (not all groups 
carried by all sites)

Private newsgroup servers: Some newsgroups are not publicly available
and appear only on a single server. For example, a company might set
up newsgroups accessible only to employees or only to members of a
particular work group. The Cyberdog newsgroups listed in your First
Notebook are available only from the news server at cyberdog.apple.com.

To see all the newsgroups your Internet Service Provider (ISP)
provides, choose Show News Groups from the Mail/News menu. For
more information on newsgroup names, see the article “Guidelines on
Usenet Newsgroup Names” in the newsgroup news.announce.newusers.
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Newsgroups for Macintosh users

Many newsgroups are of interest to Macintosh users.

The following list, while not exhaustive, presents a sample of what’s
available for users at all levels of expertise.

alt.sys.mac.newuser-help

New users ask questions here, and experts (and sometimes other new
users) answer them.

aus.computers.mac

Australians swap all manner of Macintosh information here. While
some topics apply only to local people (“Is there a decent software store
in Sydney?”), most are more general.

biz.marketplace.computers.mac

One of many groups set aside for buying and selling, this newsgroup
contains listings of new and used hardware and software for sale or
trade. Be sure to read the FAQs before you post an article or purchase
an item.

comp.binaries.mac

This group contains software that you can download and use. You may
be expected to send a small payment to the author after you’ve used the
software for a while and decided to keep it. 

WARNING  Some software in the comp.binaries.mac newsgroup is in
a developmental rather than finished stage. Software that is in a
developmental stage may “freeze” your computer system. In such
a case you’ll have to restart your computer, and any unsaved
changes to open files will be lost. Apple Computer, Inc., does not
guarantee or provide technical support for any of the software in
this or any other newsgroup.
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comp.sys.mac.*
The comp.sys.mac.* newsgroups concern themselves with all manner of
things Macintosh, and are all highly recommended. (The asterisk [*] is
a “wild card” character and stands for any word that specifies a
particular group.) There are currently about 30 such newsgroups.
Names include comp.sys.mac.games, comp.sys.mac.hypercard,
comp.sys.mac.portable, and comp.sys.mac.printing. The newsgroup
comp.sys.mac.comm is likely to have discussions about Cyberdog.

cyberdog.*
The cyberdog.* newsgroups provide discussion space for Cyberdog
issues. Newsgroups include cyberdog.announce (information about new
Cyberdog releases, documentation upgrades, and the like),
cyberdog.general (general discussion of Cyberdog issues),
cyberdog.hi-features (human interface issues and suggestions), and
cyberdog.programming. 

Note:  Cyberdog newsgroups are not available through your Internet
access provider. They are available only through the
cyberdog.apple.com news server. Access to this server is already set up
for you in the News Groups window.

fj.binaries.mac

This group is like comp.binaries.mac, except in Japanese. In most
cases, you need to have a set of Japanese-language fonts installed on
your computer to read these articles.

fr.comp.sys.mac

This group contains articles about all manner of Macintosh issues 
in French.

misc.forsale.computers.mac-specific.*
Like biz.marketplace.computers.mac, this series of groups contains
listings of new and used hardware and software for sale. There are
separate groups for video cards, portable computer systems, software,
and more.
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tamu.micro.mac

This group has Macintosh-related information of interest to students at
Texas A&M University. There are many hierarchies of special interest
to the students and faculty of individual universities (such as “ucb” for
the University of California at Berkeley and “osu” for Ohio State
University) and geographic areas (such as “ba” for the San Francisco
Bay Area and “nyc” for New York City).

Setting up Cyberdog for news

To send news, you must configure the Mail & News Setup dialog box
as described in the section “Setting Up Cyberdog for E-Mail” in
Chapter 4.

To read news, you may want to add a news server, set the distribution
for posted articles, and set the number of articles to download, as
follows.

1 Choose Mail & News Setup from the Mail/News menu.

2 Click the News icon.

3 If you want to add a news server for your Internet Service Provider (ISP) account,
company, or school, click the Add button under Servers.

The “Add a news server” dialog box appears.

55 Chapter  5   Us ing Other  In ternet  Serv ices



4 Enter the name of the news server.

5 If the news server you’re adding requires authentication, enter your user name and
password.

You will be provided with a user name and password if your news
server requires authentication.

6 If you want to save your password, click Save Password.

If you click Save Password, you won’t have to enter your password each
time you connect to the news server.

7 Click OK.

8 Type the distribution for articles that you post in the “Distribution for posted articles”
box, or choose an entry in the pop-up menu.

If you usually want the articles that you post to be distributed
worldwide, choose “global.” If you want them to be seen only by people
who receive news from the server the articles are posted to, choose
“local.”

9 Type the number of articles you want Cyberdog to download when you open a
newsgroup.

Choosing a smaller number will speed up the download process but
you may not see all of the articles in the newsgroup.
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Finding newsgroups
You can find newsgroups you are interested in by browsing through the
newsgroups list or using the search window. If you already know the
name of the newsgroup you’re interested in, you can go directly there
by entering the URL.

To find newsgroups by browsing through the newsgroups list:

1 Choose Show News Groups from the Mail/News menu.

2 Double-click the icon of the newsgroup you want to use.

You may need to open a number of hierarchy folders to find the newsgroup
you’re interested in.

After a few moments, the newsgroup you’ve chosen opens in a new window.
The following illustration shows a list of typical articles and threads from the
newsgroup.
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To find newsgroups using the search window:

1 Choose “Search for News Groups” from the Mail/News menu.

2 Type a single word that indicates the topic you’re interested in in the “Search for” box.

Cyberdog looks for all newsgroup names that contain the topic word
and displays them in the Search window.

3 To open a newsgroup, double-click the newsgroup name in the list.

To find newsgroups by entering the newsgroup URL:

1 Choose Connect To from the Cyberdog menu.

2 Type the URL for the newsgroup in the “Connect to URL” box.
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Reading articles in a newsgroup

You read an article by double-clicking its icon in a newsgroup’s
window. The article appears in a message window, for example:

A thread is an ongoing discussion of a basic theme. In a newsgroup, a
discussion thread appears as a series of articles. The name of the
original article in a thread, preceded by “Re:”, is nearly always used as
the name of subsequent articles in the same thread. To read the next
article in a thread, click the triangle next to the first article to make the
triangle point downward. Then double-click the next article to read it.

Note: Some newsgroups are designated as special places to distribute
binary files, such as pictures or programs. You can identify these groups
because their names usually end in “.binaries”. To download a binary
file, choose Download Binaries from the Message menu.
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Subscribing to a newsgroup

Once you locate a newsgroup that you’re interested in, you subscribe 
to it—that is, you drag its icon to a notebook. Whenever you want to
read articles in that group, you double-click its icon and the 
newsgroup opens.

Cyberdog keeps track of the articles you’ve already read so that you
don’t have to sift through them again each time you open a newsgroup.

Posting news

To publish an article in a newsgroup:

1 Choose New Message from the Mail/News menu.

2 Make sure the From box includes the name you want to use, a space, and your e-mail
address enclosed within angle brackets.

If the information is not there, enter it manually.

3 Type the subject of the article in the Subject box.

4 Enter the name of the newsgroup or newsgroups to which you want to post the article.

You can also send copies of the article to individuals by entering e-mail
addresses into the To, CC, and BCC boxes.

5 Type your article into the content section, dragging the icons of any files you want to
include into this section.

6 Edit the article as necessary.

Remember that thousands of people may read your message.

7 Send your article.

To send your article immediately, click the Send Now button at the top
of the Message window. You can also click the Send Later button.
When you are ready to send the message, select the message in the Out
Tray then open the Message menu and choose Send Now.
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Transferring files with FTP

You use FTP (File Transfer Protocol) to exchange files with computers
on the Internet. 

For additional information about FTP, see the “Transferring Files With
FTP” topic area of Cyberdog Guide, available in the Guide (h) menu
when Cyberdog is active.

Connecting to an FTP server

To connect to an FTP server:

1 Choose Connect To from the Cyberdog menu.

2 Click the FTP icon.

3 Type the name of the FTP server you want to connect to in the Host box.

4 If you want to connect to a specific directory or file, enter the path in the Path box.

If you’re not certain, leave it blank.

5 If you have an account at the FTP server, click Registered User.

Otherwise, click OK.

6 If you selected Registered User in step 5, type your user name and password and click
OK.

If you want Cyberdog to remember your password (and avoid having to retype
it each time you connect to this location), click the “Save password” checkbox
to put an X in it.

7 When the FTP server appears, browse through directories by double-clicking them.

Look for files with names such as “Read Me” or “File organization” for
information about how to find items that interest you or about the most
appropriate places to store files.

To easily reconnect to this FTP server later, you can save its address icon by
dragging the address icon in the upper-left corner of the FTP window to a
notebook, a folder, or the desktop.
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Getting a file from an FTP server

To get a file from an FTP server:

1 Open the FTP server you want to work with.

2 Locate the item or items you’re interested in and drag them to your hard disk.

You can also choose Get Items From Server from the FTP menu.

As you’re downloading a file, a progress bar at the lower-right corner of the
window indicates how much of the file remains to be downloaded before the
transfer is complete. You can cancel the download by clicking the running
dog icon at the lower-left corner of the status window.

Anonymous FTP archives

Anonymous FTP archives are collections of files to which you can gain 
access without an assigned password. Such files include application
software, graphics, collections of sounds, and databases. These archives
are often maintained by universities, government agencies, and large
computer companies. 

Many computer sites allow access to their files only if you have a user
ID (also called a login name) and a password assigned by the site
administrator. Anonymous FTP archive sites, however, accept the word
“anonymous” as the user ID and your e-mail address as the password.
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Technical support may be available:  Although Apple Computer, Inc.,
does not provide technical support for any software you may retrieve,
the software’s creators sometimes provide technical support. See the
documentation that comes with the software.

Why do they do it?  Site administrators often find it more convenient
and practical to maintain anonymous FTP archives than to set up
password accounts for everyone who might have a legitimate need to
access certain files. Computer companies, for example, might want to
allow customers free access to system software updates and bug fixes,
while universities might want students to get online catalogs and class
schedules easily. (The Cyberdog software you downloaded from
cyberdog.apple.com was actually at an FTP site.)

Restrictions

The administrators of anonymous FTP sites (the computers where the
archives are stored) often place restrictions on using their archives. You
have access to the files only in certain folders (called directories on
most Internet systems), and there may be limits on the number of files
you can retrieve (download) or the amount of time you can spend
connected to a site. To see what restrictions apply, open the FTP menu
and choose Show Server Messages. You’ll see a window like the one in
the following illustration.

Many sites do not allow you to transfer any files from your computer to
the archive (upload). Still, because all the files that you download are
either free or extremely inexpensive, anonymous FTP is the best deal
on the Internet.
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Finding FTP sites

You can use the Cyberdog Internet Search page to locate FTP sites.
Follow these instructions:

1 Open the Cyberdog Tour window and click Search.

When the Search page opens, you might want to drag the Internet
Search icon at the top-left corner of the window to your notebook.
Most people find that they use Search quite often.

2 Type Mac “anonymous FTP” in the Search field and press Return.

Remember to type the quotation marks around the phrase 
“anonymous FTP.”

3 Click a site name.

You may have to investigate a number of sites before you find one that 
you like.

You can be specific in your searching:  You can also use a search engine
to find a specific file or file type. Instead of searching for anonymous
FTP, search for Compression Software and see what happens.

You’ll find a list of useful FTP sites on Cyberdog’s World Wide Web
home page. You can reach that page by clicking the Explore button in
the Cyberdog Tour window, or by connecting directly to the Internet
address http://cyberdog.apple.com.

Finding files in an archive

Many FTP sites have files with titles such as Read Me and Directory
Listings that provide hints about searching the archives. (You can’t use
application software from your computer’s hard disk to locate files at
the anonymous FTP site.) Additionally, many sites have Welcome
messages that appear when you first connect, giving additional hints
about where to look.
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In the worst case, you’ll have to browse through directories until you
find what you want, using the directory names themselves as hints.
Start with the directories named “mac” or “pub” (short for “public”).
Browsing directories is simple; you double-click a folder to open it, just
as you do in the Finder. Files and subfolders are always listed
alphabetically, as if “by Name” were chosen in the Finder’s View menu.

To download a file, just drag its icon to your desktop or hard disk. The
file is copied to your computer.

Using Gopher

You use Gopher to find interesting files no matter where they are on
the Internet. Gopher is like FTP in that you can use it to retrieve files;
but while FTP can only show lists of files that are on the host computer
to which you’re connected, Gopher can show lists of files that are on
many computers. 

Typical Gopher lists are arranged in hierarchies with each folder named
for its content. Using Cyberdog, you browse through folders until you
find the file that interests you. Then you double-click its name to read
it or drag it to the desktop to download it.
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For additional information about Gopher, see the “Transferring Files
With Gopher” topic area of Cyberdog Guide, available in the Guide (h)
menu when Cyberdog is active.

Connecting to a Gopher server

To connect to a Gopher server:

1 Choose Connect To from the Cyberdog menu.

2 Click the Gopher icon.

3 Type the name of the Gopher server you want to connect to in the Host box.

4 If the Gopher server requires you to connect to a specific port, enter the name or number
of the port.

If you’re not certain, leave it blank.

5 Click OK.

6 When the Gopher server appears, browse through directories by double-clicking them.

Look for files with names such as “Read Me” or “File organization” for
information about how to find items that interest you or about the most
appropriate places to store files.

To easily reconnect to this Gopher server later, you can save its address icon
by dragging the address icon in the upper-left corner of the FTP window to a
notebook, a folder, or the desktop.

Getting a file from a Gopher server

To get a file from a Gopher server:

1 Open the Gopher server you want to work with.

2 Locate the item or items you’re interested in and drag them to your hard disk.

You can also choose Get Items From Server from the Gopher menu.

As you’re downloading a file, a progress bar at the lower-right corner of the
window indicates how much of the file remains to be downloaded before the
transfer is complete. You can cancel the download by clicking the running
dog icon at the lower-left corner of the status window.
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Using Telnet

You use Telnet to log onto other computers so that you can use their
programs and data as if those items were on your own hard disk. Many
libraries, for instance, have electronic (online) card catalogs that you
can access by using Telnet software. There are a variety of other
specialized databases that you can access through Telnet.

For additional information about Telnet, see the “Logging in to Remote
Computers” topic area of Cyberdog Guide, available in the Guide (h)
menu when Cyberdog is active.

Connecting to a Telnet site

To connect to a Telnet site:

1 Choose Connect To from the Cyberdog menu.

2 Click the Telnet icon.

3 Type the name of the Telnet site you want to connect to in the Host box.

4 If the Telnet requires you to connect to a specific port, enter the name or number of the
port.

If you’re not certain, leave it blank.

5 If the site you connect to requires a special kind of terminal, select the text in the
Terminal Type text box and enter a new terminal type.

The default terminal type works with most Telnet sites.

6 To change the settings for the selected terminal type, click Terminal Configuration and
choose the settings you want. Then click OK.

7 Click OK.

8 When the session window opens, follow the instructions you see on the screen.

If you don’t see any instructions, try logging in with the name “guest.”
If that doesn’t work, you may need an account and a password to access
the site. Contact the site’s administrator for information.

Note: To easily reconnect to this Telnet site, click in the Telnet window.
Then choose “Add Window to Notebook” from the Cyberdog menu.
The address icon is added to your default notebook, and you can drag it
to a folder or the desktop.
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About file suffixes

You may need to decompress downloaded files before you use them.
Files stored in archives are often compressed in order to save space.
Such files end in a one-, two-, or three-letter suffix preceded by a
period (for example, “pictures.sit” or “files.hqx”).

Many compressed files are automatically expanded by your software.
You may need to expand others yourself with special software. Software
for expanding compressed files is often available at the same site that
holds the compressed files you were originally looking for. (See
“Finding FTP Sites,” earlier in this chapter.)

About shareware

Shareware is software that you use on approval. Unlike demoware,
shareware is a complete software package. You get all the features, not
just a sample. After you use the software for a while, the author expects
you to send payment or to throw the software away. Shareware is usually
quite inexpensive. 
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Cyberdog’s AppleTalk browser allows you to access AppleShare and
other AFP (AppleTalk Filing Protocol) servers. AppleShare URLs can
be used to open documents, launch applications, and open folder
windows on remote volumes. These URLs can also be added to
Cyberdog notebooks or embedded in Cyberdog custom documents for
later use.

For additional information about accessing AppleTalk networks, see the
“Accessing AppleTalk Network” topic area of Cyberdog Guide,
available in the Guide (h) menu when Cyberdog is active.
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Browsing AppleTalk networks

The AppleTalk browser gives you access to zones and servers on your
local area or wide area AppleTalk network. In Cyberdog, AppleTalk
zones and AppleShare file servers have their own URLs. Just like
standard Internet URLs, these URLs can be added to Cyberdog
notebooks, HTML Web pages, and Cyberdog custom documents.

Accessing AppleTalk zones and AppleShare file servers

IMPORTANT  To see anything in the browser window, your computer must
be connected to an AppleTalk network and AppleTalk must be active.  

1 Open the AppleTalk browser.

Use one of these methods:

m Click the AppleTalk button in the Cyberdog Tour window.

m Double-click the AppleTalk Network listing in the notebook.

m Choose Connect To from the Cyberdog menu, click the URL icon,
and type the URL

at:

A window similar to the one shown below appears, which is a list of
zones for the AppleTalk network to which you are connected. (This is
the list you get when you open the Chooser and select the AppleShare
icon.)
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2 To see the AppleShare file servers in a zone, click the triangle next to the zone.

The window below shows the AppleShare file servers in the 
Marketing zone.

3 To connect to a file server, click the triangle next to the server.

The authentication dialog box appears.

4 Log onto the file server.

Once you gain access to the server, you see a list of available volumes.
Double-clicking connects you to the volume and opens its window in 
the Finder.  
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Using AppleTalk and AppleShare URLs  

AppleTalk and AppleShare URLs can be used just like standard
Internet URLs. For example, you can put links to AppleShare file
servers on the same HTML Web page as links to Internet resources.
However, only people who browse the Web using Cyberdog will be
able to connect to servers with AppleTalk and AppleShare URL links.
For more information on using AppleTalk and AppleShare URLs in
HTML Web pages, go to http://cyberdog.apple.com and click the
AppleTalk Browser link.  

You can enter URLs to access your AppleTalk network at any level
from zone to file. The following list shows which URLs match 
which levels:

m AppleTalk network URL  at: (the letters “at” followed by a colon)

m AppleTalk zone URL  at://Zone Name

m AppleTalk local zone URL  at://*

m AppleShare file server URL  afp:/at/Server Name:Zone Name

m AppleShare volume URL  afp:/at/Server Name:Zone Name/Volume Name

m folder URL  afp:/at/Server Name:Zone Name/Volume Name:Folder Name

m file URL  afp:/at/Server Name:Zone Name/Volume Name:File Name

You can enter authentication information in any AppleShare URL. For
example, you can allow guest access to an AppleShare file server URL 
as follows:

m afp:/at/guest@Server Name:Zone Name

You can add a user name and password to a file server URL as follows:

m afp:/at/user name:password@Server Name:Zone Name

You can add AppleTalk URLs to a notebook exactly as you add Web 
page URLs.

1 Open a notebook.

2 Choose New Item from the Notebook menu.

3 Type the URL and click OK.
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Adding AppleTalk and AppleShare URLs to cyberdocuments 

You can use the AppleTalk browser and AFP URLs to create unique
ways to access your AppleTalk network’s resources. Cyberdocuments
and web pages can embed AppleTalk browser and URL links to your
local AppleTalk network, providing access to zones, servers, volumes,
and files. See Chapter 7 of this manual, “Creating Cyberdocuments,”
for more information.
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With DocBuilder, you can quickly and easily create customized access
to Internet or intranet resources. DocBuilder is an application provided
with Cyberdog that you can use to create cyberdocuments, an entirely
new kind of multimedia document based on Apple’s new LiveObjects
(OpenDoc) technology. Cyberdocuments can include text, graphics,
and Internet information. You can embed Cyberdog parts that access
Web pages, FTP servers, Gopher servers, AppleTalk networks,
AppleShare servers, newsgroups, and Cyberdog mail trays in
cyberdocuments. Links can be to Internet resources, intranet resources,
or files on your local hard disk or network.

DocBuilder is similar to a drawing application. If you’ve used a drawing
application before, you’ll recognize the tools. If not, you’ll find them
easy to learn.

This chapter takes you through the building of a sample
cyberdocument, giving a glimpse of all the features available.

For additional information about cyberdocuments, see the “Creating
Cyberdocuments” topic area of Cyberdog Guide, available in the Guide
(h) menu when Cyberdog is active.

7 Creating Cyberdocuments



Unique cyberdocument features

Cyberdocuments can serve many of the same purposes as a Web page,
but they are not the same:

m Cyberdocuments are Macintosh files that you create on your desktop,
not HTML Web pages that reside on a remote Web server.

m You can embed information from multiple Internet sources,
including newsgroups, mail, and AppleShare servers, with 
single-click access to all sources.

m You can add URLs, text, and graphics to cyberdocuments.

m You can provide live views that show the actual content of 
Internet sites.

m Cyberdocuments can be accessed only by Cyberdog users, and each
user must have a copy on his or her computer to access the
document.

Using DocBuilder

This section introduces you to the basic DocBuilder controls. You’ll
save time and trouble if you familiarize yourself with the following
information before building your first cyberdocument.

Selecting and editing 

There are two types of selection. When you click a part such as a
button, a dotted frame appears. This indicates that the part is “active,”
meaning that you can edit its contents. Any DocBuilder Tools palettes
that are open disappear when the part is active, as do the Layout and
Page menus. At the same time, the part’s unique menu becomes
available, indicating that control has passed from DocBuilder to the part
itself (for instance, when you click a button, the CyberButton menu
appears).
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When you click outside an active button or other part, dark squares, or
handles, appear on the corners of the button, indicating that the part 
is selected.

While the part is selected, you can resize the part by dragging one of
the handles. You can also select multiple parts by Shift-clicking and
then align, move, or do other operations with the parts as a group. If
you have trouble selecting a part, try clicking and dragging around it to
select it.

Deleting 

You can delete objects by selecting them and pressing the Delete key.
You can also use Cut or Clear in the Edit menu.

Making documents editable or uneditable

You use layout mode to create your cyberdocument. When the
document is set to layout, you can add parts, edit text, resize and move
parts, link buttons, and drag in Internet address icons to create new
viewers (in layout mode, a grid of dots appears within the document).

Run mode is somewhat analogous to read-only. In run mode, you 
can only select and change those objects that were set “Editable in 
Run Mode.”

To make a part within a cyberdocument unchangeable by the user,
select the object (so the dark square handles show) and choose
“Editable in Run Mode” from the Layout menu. The checkmark by the
menu item disappears, indicating that the selected DocBuilder part is
no longer editable in run mode. You can select multiple objects (by
Shift-clicking or by dragging a selection box) and change all of them at
once. When a part is not editable in run mode, the user can’t edit the
item in any way, so if you want users to have the option of changing a
button, notebook, or other part within the cyberdocument, be sure to
leave it set to “Editable in Run Mode.” Generally, you should set
decorative items, such as text labels, pictures, and other graphics, to be
not editable in run mode. Graphic objects created with the DocBuilder
Tools palette are never editable in run mode.
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Saving a document as run-only

When you save a cyberdocument you’ve set to run mode, anyone who
opens it can use the Tools palette or Edit menu to change it back to
layout mode. The Save as Run Only option in the File menu “locks” the
document, so that it can’t be changed back to layout. Before saving a
document as run-only, you should also save an editable version. If you
save a document as run-only and later need to edit it, you can open a
new cyberdocument and drag the run-only document icon into the new
document.

Options for linking a button

You can create a link to a button by dragging the address icon onto the
button from your Log, a notebook, or the desktop. You can also create a
link by using Link To in the CyberButton menu. This method lets you
link to your Log, your default notebook, and any URL.

Adding text to a button

To put text on a button, first create the text using a drawing or painting
program. The text is now the same as a picture. It can be worked with
inside cyberdocuments or added to cyberbuttons exactly as any 
other picture. You can also also type a label on the button using the
Label option in the CyberButton menu.

Adding graphics and text to a cyberdocument

You can often drag graphics or text directly from another open
application into DocBuilder. Normally, when you drag something in
from the Scrapbook, you see a light blue border around the
cyberdocument, indicating that it’s accepting the object. If DocBuilder
doesn’t accept the dragged item, the item zooms back to its original
place. If the item is rejected, either drag or copy and paste the item into
the Scrapbook before dragging it into DocBuilder, and check that the
cyberdocument is set to Layout (in layout mode, a grid of dots appears
within the document).
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Creating a scrolling text box

You can create scrolling text boxes in DocBuilder. If you create such a
box, be sure to leave that part editable; otherwise the user won’t be able
to scroll the box. If you include a large amount of text in a box and
don’t want the user to be able to change the text, you need to use small
enough fonts and create a text field large enough for the user to view
the entire passage without scrolling.

Including existing text

If you have previously written text you want to include in a
cyberdocument, one option is to copy the text from its original
document and paste it into the cyberdocument. Another option is to
drag a file that’s been saved as text-only from your desktop into the
cyberdocument. DocBuilder creates a text viewer and displays the text.

Both methods of including text cause most of the formatting to be lost;
only default tabs, spaces, and styling are saved. Once the text is in
DocBuilder, you can edit it, format it, and add additional styling.

Note: Cyberdog cannot show transparent text. You can achieve this
effect by putting the text inside a white fill rectangle, or by using a
draw or paint program to create the background you need.

Controlling navigation in embedded browsers

If you embed a browser window “as is,” it will contain its full header
with a variety of navigation options. Some of these options may not be
appropriate for your purposes. You can use the Navigate menu to
determine what header information appears. The settings you make
with the Navigate menu apply only to the selected browser.



Creating a cyberdocument

This section takes you step by step through the process of using
DocBuilder to create a custom cyberdocument that includes a button
linked to a Web site and an embedded Web browser. 

1 Open the Samples and Tools folder.

2 Double-click the Cyberdog DocBuilder icon.

The DocBuilder layout window opens. The grid of dots, which serves
as a reference grid for aligning items, indicates that this is a layout
document (as opposed to a run-only document, which is “locked” to
prevent it from being edited). A run-only document window has no
grid of dots. To make the document run-only, click the running dog on
the Tools palette. Clicking the lying-down dog changes the document
back to layout, making it editable. You can also change between layout
and run modes using the Layout/Run Mode command in the 
Edit menu.

Two tool palettes also open: DocBuilder Tools and Cyberdog Parts. If
these palettes are in your way, you can move them to a different
location on your screen, or close and reopen them when needed using
the Hide/Show DocBuilder Tools and Hide/Show Cyberdog Parts
commands in the Layout menu.
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3 Add a graphic to the top of the document by opening the Scrapbook (from the Apple [K]
menu), selecting any picture in it, and dragging the picture into the open document.

You can also copy the picture and then paste it into the cyberdocument. 

4 Center the graphic at the top of the cyberdocument.

The picture will appear in the selected state (clicking anywhere within
the picture puts it into its editable state). Drag or resize the picture
while it is in the selected state and without releasing the mouse button.
If you click and release the mouse button, you put the picture into its
editable state and the resize and drag functions will not work.

5 Select the text tool by clicking the icon marked with an A on the parts palette.

6 Move the pointer to the location where you want to place the text.

The pointer changes to a crosshair. 

7 Create the text area by dragging the crosshair while holding down the mouse button.

The text box initially appears in its selected state so that you can
reposition and size it. To put it into its editable state, allowing you to
add text, click anywhere inside the box. The dotted border appears, as
does a blinking insertion point.

8 Type the text.

9 Change the font, color, and size to your liking.

Use the commands in the Text menu to change the size, style, font, and 
color. You can apply style to any part of the text or all of the text,
depending on what you select. 

10 Resize the text box as needed to fit the text.

To resize the text box, click the gray border. Dark square handles
appear on the corners of the button, indicating that the text box part is
selected. While the part is selected, you can resize it by dragging one
of the handles so that all the text appears.
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11 Add a button to the document by clicking the button icon in the parts palette and
dragging it into position in the DocBuilder window.

As you drag the button from the parts palette over the DocBuilder
window, the pointer changes to a crosshair. You can also create a button
by clicking the icon and then dragging the crosshair, just as you did to
create a text box.

12 Adjust the size of the button as desired.

Dark square handles appear on the corners of the button, indicating
that the part is selected. While the part is selected, you can resize the
part by dragging one of the handles. You can also select multiple parts
by Shift-clicking and then align, move, or do other operations with the
parts as a group.

13 Add a graphic to the button by dragging one from the Scrapbook.

If the graphic needs to be resized, you need to use a paint or draw
application before you place the graphic in DocBuilder.

You can use an embedded picture to decorate your cyberbutton:

a. Put the picture into its editable (dotted border) state.

b. If necessary, resize the picture using the Picture menu that appears
when the picture is in an editable state.

c. Drag a selection rectangle inside the dotted border to select all or
part of the picture.

d. Use the Copy and Paste commands or just drag the selection to 
the cyberbutton.

You can have the icon of the item it points to appear on the button by
choosing Show Icon from the CyberButton menu. Or you can type a
label on the button using the Label option in the CyberButton menu.
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14 Set a color for the button using the CyberButton menu.

You can assign a color or make the button clear so that background
pictures can appear through it.

15 Link the button to an Internet site by dragging an address icon from the desktop, the
Log, or any Notebook to the button. You can also use the “Link to” items in the
CyberButton menu.

The address icon might be at the upper-left corner of a browser
window, in the Log, in a notebook, in a folder, or on the desktop.

The button flashes, indicating that the Internet address is linked to 
the button. (You can choose Get Info from the Edit menu to find out to
which Internet site the button is linked.)

To try out the button, switch the document to run mode. The
background grid of dots disappears when you switch to run mode.
After you’ve tried the button out, switch back to layout mode in order to
make additional changes to the document.

Note: You can also link a button to an AppleTalk address or Cyberdog
window (the default notebook, the Log, the Connect dialog box, or the
Cyberdog Preferences dialog box).
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16 Add a notebook by clicking the notebook icon in the Cyberdog palette.

You can drag the notebook to the DocBuilder window, or select the
notebook and then resize it with the crosshair.

Embedded notebooks behave exactly like notebooks on your desktop.
You can add, delete, and rearrange items and categories and double-
click an item to go to the Internet site it represents. The embedded
notebook even scrolls, exactly like its desktop twin.

You can put Internet addresses in the notebook by dragging them from
your Log, from another notebook, or from the Macintosh desktop
(Finder). You can also select the notebook and use the Notebook menu
to add categories or items to the notebook the same way as you do with
the default notebook.

17 Add a Web, FTP, AppleTalk, or Gopher view to a DocBuilder cyberdocument.

You can add real-time Web and AppleTalk browsers, FTP, and Gopher
sites by dragging URLs into the cyberdocument. When the connection
is made, the window will open and resize itself. To resize the browser,
put it into the selected state by clicking the dotted border, and then
drag a handle. 

IMPORTANT  When a cyberdocument opens, embedded browser windows
automatically connect to their sites. This can cause problems for users
who are not connected to the Internet or the appropriate AppleTalk
network. Cyberbuttons avoid this problem because they don’t make the
connection until clicked by the user.
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18 Add draw elements by selecting them from the DocBuilder palette.

The crossed lines give you horizontal or vertical lines; the angled line
lets you draw lines at various angles. You can also create boxes and
circles, or borders, and you can add bevel effects. The colored buttons
let you select color for the border and its area; to select line width,
choose Pens from the Layout menu. 

19 Save the document.

You may want to save the document in run mode so that users cannot
change it, as described earlier in this chapter.
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8
This chapter helps you address problems you may have while setting
up and using Cyberdog.

For additional information about troubleshooting, see the
“Troubleshooting” topic area of Cyberdog Guide, available in the Guide
(h) menu when Cyberdog is active.

A Cyberdog list of Frequently Asked Questions (FAQs) is available 
on the Internet at http://cyberdog.apple.com/br/faq.html. The FAQ is 
an ongoing document that is continually updated as new questions
come in.

Troubleshooting



You receive “out of memory” errors.

Click the Cyberdog icon to select it. Choose Get Info from the File
menu. Double-click the “Preferred size” box and type a new number.

If you are using Netscape plug-ins or Java applets, you may want to
increase the memory to 5000 kilobytes.

Your system crashes and your Cyberdog preferences are not being used.

Your Internet Preferences file is corrupt. Quit Cyberdog. Then delete 
the Internet Preferences file (located in the Preferences folder, which is
inside the System Folder). Restart Cyberdog and then reset your
preferences.

You can send mail but you can’t download mail from your account.

Make sure that you’ve entered the correct account name and host in the
Account Info dialog box. To display this dialog box, choose Mail &
News Setup from the Mail/News menu, click the Mail Trays icon, and
click the Modify button under Mail Accounts. If you still can’t
download mail, contact your network administrator.

You can download mail from your account but you can’t send mail.

Make sure that you’ve entered the correct SMTP host in the Mail &
News Setup window. To display this dialog box, choose Mail & News
Setup from the Mail/News menu and click the Mail icon. If you still
can’t send mail, contact your network administrator.

A URL in your notebook is out of date.

You must recreate the item in the notebook. Open the notebook and
choose New Item from the Notebook menu. Click the appropriate
service icon and enter the new URL in the “Connect to URL” box.
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This chapter provides keyboard shortcuts you can use to maneuver
easily through Cyberdog windows.

Appendix: Shortcuts



Shortcut Result

General

Page Up, Page Down, Home, End Navigates through all Cyberdog windows

Enter Opens a selected item in a Cyberdog window

x–Down Arrow Opens a selected item in a Cyberdog window

Option–Drag hypertext link to Finder File available on Finder that you can double-click to take
you to that site or service

Mail/News

Space bar In an open message window, moves you to the bottom of
the page; at the end of the message, opens the next
unread message

x–Right Arrow When reading a received message, goes to next
message, regardless of the read/unread status. If you
also hold down the Option key, deletes current message
while opening next.

x–Left Arrow When reading a received message, goes to previous
message, regardless of the read/unread status. If you
also hold down the Option key, deletes current message
while opening previous.

Option–Right Arrow When editing a message, moves the pointer forward one
word. If you also hold down the Shift key, also selects.

Option–Left Arrow When editing a message, moves the pointer back one
word. If you also hold down the Shift key, also selects.

Option–Double-click Forces a message to open in the TextViewer (which
shows header and text in raw format)

Option–click column Sorts items in Mail Tray category (Subject, From, Date)
in reverse of normal 

Option–choose Empty Trash Empties trash in Mail Tray without warning message
from the Trays menu

Option–Space bar or Option–Return Deletes the current message and opens the next unread
message

x–Delete or Option–Reply Deletes the current open message

Option–Delete Deletes tray or group of trays without warning message

Control–Click close box Compacts mail database space
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access privileges  The ability to see or retrieve directories (folders) and
files, to make changes to a directory, or to run programs at an FTP or
Telnet site. Access privileges are granted by the administrator of the
site. See also FTP, Telnet.

address icon  An address icon contains the address for an Internet item.
The item can be a World Wide Web page, a Gopher or Telnet server, 
a Gopher or Telnet document, a newsgroup, or even an individual’s 
e-mail address. When you double-click an address icon, you go directly
to that Internet location.

anonymous FTP  The process you use to connect to a remote computer
whose files you can access without having an account. It’s called
anonymous FTP because you typically type the word “anonymous” as
your user ID. See also FTP, remote computer.

AppleShare  Network service software that allows users to store and share
documents, folders, and applications over an AppleTalk network.

AppleTalk  A communications environment in which many different
kinds of computers, peripheral devices, and software can work together
according to protocols (rules) developed by Apple Computer.

AppleTalk Filing Protocol (AFP)  The presentation-layer protocol that allows
users to share data files and application programs that reside on a file
server.

article  A message published in a newsgroup.

bcc  In e-mail, a recipient who receives a “blind copy” of a letter and its
attachments (so called because no other recipients know about the bcc
recipient). See also e-mail.

browser  Application software you use to investigate the World Wide Web.
Clicking the Explore button in the Cyberdog Tour window enables you
to browse the Web. See also World Wide Web.
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cc  In e-mail, a recipient who receives a carbon copy of a letter and its
attachments. See also e-mail.

cyberbutton You use a cyberbutton to add Internet functionality to any
document that accepts Live Objects. Within a document, you can use a
cyberbutton to connect to the Log, the default notebook, the Connect
window, the Preferences window, or a specific Internet location.

cyberdocument Also known as a Cyberdog custom document or
DocBuilder document, this is an OpenDoc document that contains
Internet functionality. By clicking hypertext links within a
cyberdocument, you can connect to Internet sites and display 
Internet-based information. A cyberdocument offers capabilities
similar to that of a Web page, but unlike a Web page, Cyberdocuments
aren’t in http format. The Cyberdog Tour window that appears when
you start up Cyberdog is an example of a cyberdocument.

Cyberdog document  See cyberdocument.

default notebook Cyberdog uses the default notebook when you choose
“Get Address from Notebook” from the Message menu, when you
choose “Show Default Notebook” from the Cyberdog menu, or when
you click the Notebook button in the Cyberdog Tour window. You set
the default notebook by choosing the Set Default Notebook command
from the Notebook menu.

demoware  Software that you are allowed to try out at no charge before
purchasing. Most demoware has built-in limitations that prevent you
from using it on a permanent basis.

directory  The word for “folder” on many host computers.

distribution  The distribution of an article is the geographic range through
which it is sent. For example, an article with global distribution is sent
to computers around the world, while one with “ba” distribution is seen
only by computers in the San Francisco Bay Area.

DocBuilder  The Cyberdog text and drawing utility that you use to 
create cyberdocuments.

download  To copy a file from another computer to your own computer
over a communications link.

e-mail  Electronic mail.
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enclosure  An enclosure is any file included with, but separate from, an
e-mail message or newsgroup article. In Cyberdog, an enclosure icon
appears in the body section of a message window.

freeware  Software that is distributed at no cost. Distinguished from
shareware, for which payment is requested.

FTP  Abbreviation for File Transfer Protocol, the set of rules (the
protocol) that the Internet uses to facilitate the transfer of files 
between computers. 

Gopher  An information retrieval system developed by the University 
of Minnesota.

header  The information that appears at the top of every e-mail message
or newsgroup article. The header contains data about the sender, the
date the message was created, the computer path the message traveled
through, and other information used for the distribution or management
of the message. See also e-mail, newsgroup.

home page  The default World Wide Web document you go to when you
click the Explore button in the Internet Pathfinder. See also
browser, World Wide Web.

host computer  A remote computer that you connect to in order to retrieve 
mail, documents, application software, or other files; search databases;
run programs; and take advantage of other services the remote
computer may provide.

HTML  An acronym for Hypertext Markup Language, the formatting
language that World Wide Web documents are written in.

http  An acronym for Hypertext Transfer Protocol, the set of rules that
the Internet uses for moving hypertext documents.

hypertext  A system for nonlinear writing in which documents are
electronically linked to other sections of text or other documents. See
also hypertext document.

hypertext document  A document that contains text or graphics you can
click to display additional information. Web pages and the
cyberdocuments that you can create with Cyberdog DocBuilder are
both examples of hypertext documents.
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In Tray  An In Tray holds incoming e-mail from a specific mail server.
There is one In Tray for each mail server account that you’ve reached
with the Connect To command in the Cyberdog menu.

Internet  The collective name for the systems of computer networks,
made up of millions of computers from all over the world, that use the
same protocols for communication and the exchange of information. In
practical terms, the Internet is a vast international communication
system and repository of information accessible by anyone with a home
computer, proper application software, and an Internet access provider.

Internet access provider  A company that provides connections to the
Internet for a monthly fee (or sometimes for an hourly fee). Access
providers are to the Internet as telephone companies are to telephone
service: they provide access to the network but don’t usually 
provide content.

Internet service provider  See Internet access provider.

letterhead  A reusable message template.

Log  The Log holds the addresses of Internet locations that you’ve
visited from session to session.

mail handler  You use a mail handler to customize how your mail is
displayed. You can make a message stand out by assigning its title a
color, or you can move it to a specific mail tray. You can also
automatically make a copy of an outgoing message and put the copy in
a specific mail tray.

mail tray  Mail trays hold incoming, outgoing, and filed mail. In addition
to the mail trays that come with Cyberdog (In Trays, Out Tray, and
Trash), you can create as many personal mail trays as you like.

message  In Cyberdog, any newsgroup article or e-mail message appears
in a single kind of window, called a message window. Any message,
whether it’s an article or an e-mail message, is read and created the
same way.

moderated newsgroup  In Usenet, a newsgroup whose articles are cleared
by a moderator before they’re posted. An article posted to a moderated
newsgroup is automatically sent by e-mail to the group’s moderator,
who checks the article for appropriateness and then either posts it to
the group or sends it back to the author with an explanation. Most
newsgroups are not moderated. See also Usenet.
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newsgroup  In Usenet, a collection of postings (called “articles”) on the
same general theme. Anyone can post an article to any unmoderated
newsgroup. See also Usenet.

notebook  You use a notebook to store the addresses of Internet sites that
you’ve visited. See also default notebook.

OpenDoc  Apple Computer’s software that allows you to integrate many
independent parts into a single document.

page  A single World Wide Web document. Each page can have text,
pictures, and other multimedia elements. A Web site can have any
number of pages connected by links.

pathname  The list of directories (folders) you pass though to get to the
directory you want to use. On the Internet, the pathname starts with a
slash (/), and all directories in the pathname are separated by a slash.

remote computer  Also called a remote host, any computer that is in a
location other than where you are and that you use your own computer
to connect to. Compare host computer.

session  The current interaction between your computer and a 
remote computer.

shareware  Software that is distributed at no initial cost but for which
payment is requested should you continue to use the program.

signature  Text that can be automatically added to the bottom of every 
e-mail letter or newsgroup article that you write. Generally no longer
than four lines, the signature usually contains a paper mailing address
and a voice or fax telephone number.

SMTP  An acronym for Simple Mail Transfer Protocol, the set of rules
that the Internet uses for moving e-mail messages. See also e-mail.

Telnet  Process you use to log onto a remote computer. Once you’re
connected, your computer acts as a terminal to the remote computer.
See also remote computer.

thread  In Usenet, a series of articles that discuss a common topic.
Articles in the same thread have nearly the same name.

upload  To copy a file from your own computer to another computer over
a communications link.
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URL  Acronym for Uniform Resource Locator, the standard way to give
the address of any Internet location.

Usenet  The set of all host computers that run the netnews software and
that exchange newsgroups in the comp, sci, rec, soc, misc, news, and
talk hierarchies. (The exchange of other newsgroup hierarchies is
optional.) Not all Usenet sites are on the Internet. Strictly speaking,
Usenet refers to the computers that run netnews and to the people who
use this service, rather than to the newsgroups themselves.

World Wide Web  Also called the Web; the organization and presentation of
Internet information in a series of hypertext documents. Using a Web
browser, you move through the Internet by clicking images or text that
contain hypertext links. (The text is usually in a different color from
surrounding text and is often underlined.) See also browser, 
hypertext document.
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